Contents

Creating Accessible PDF Documents with Adobe Acrobat XI (11) Professional for Windows ................................................................. 5
  Description ........................................................................................................................................................................ 6
  Overview of Creating Accessible PDF Documents with Acrobat XI .......................................................... 7

Creating Accessible PDF Documents from MS Office Documents ............................................................... 9
  Structured Text in MS Word .......................................................................................................................... 9
  Textual Descriptions for Non-Textual Content in MS Word .................................................................... 11
  Table Headers in MS Word .......................................................................................................................... 12
  Converting to PDF from MS Word .................................................................................................................... 13
  Creating the PDF Document from MS Office (Summary) ................................................................. 16

Options for Converting Different Existing PDF Documents ....................................................................................... 17

Adobe Acrobat Accessibility ........................................................................................................................................ 19

Enhancing Accessibility of PDF Documents in Acrobat Pro .................................................................................. 21

The TouchUp Reading Order Tool .............................................................................................................. 25
  Adding Content with the TouchUp Reading Order Tool .............................................................................. 26
  Removing Content with the TouchUp Reading Order Tool ........................................................................... 27
  Reclassifying Content with the TouchUp Reading Order Tool ........................................................................ 28
  Evaluating and Controlling Reading Order .............................................................................................. 29
  Adding Alternative Text to Images in PDF Documents ............................................................................... 32
  Fixing Tables ...................................................................................................................................................... 33
  Table Inspector .................................................................................................................................................... 33
  Defining Table Headers .................................................................................................................................... 34

Forms with Adobe Acrobat Pro .................................................................................................................. 37
  Creating Accessible Interactive Forms .................................................................................................. 37
  Radio Buttons and Checkboxes .................................................................................................................. 39

PDF Documents and Web Browsers ........................................................................................................... 41
  For Adobe Acrobat .............................................................................................................................................. 41
  For Adobe Reader ........................................................................................................................................... 41
  Using JAWS with Adobe Reader ................................................................................................................ 41

Forms with Adobe LiveCycle Designer ...................................................................................................... 43
<table>
<thead>
<tr>
<th>Creating Accessible PDF Documents with Adobe Acrobat X (10) Professional for Windows</th>
<th>49</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>50</td>
</tr>
<tr>
<td>Overview of Creating Accessible PDF Documents with Acrobat X</td>
<td>51</td>
</tr>
<tr>
<td>Creating Accessible PDF Documents from MS Office Documents</td>
<td>53</td>
</tr>
<tr>
<td>Structured Text in MS Word</td>
<td>53</td>
</tr>
<tr>
<td>Textual Descriptions for Non-Textual Content in MS Word</td>
<td>55</td>
</tr>
<tr>
<td>Table Headers in MS Word</td>
<td>56</td>
</tr>
<tr>
<td>Converting to PDF from MS Word</td>
<td>57</td>
</tr>
<tr>
<td>Creating the PDF Document from MS Office (Summary)</td>
<td>59</td>
</tr>
<tr>
<td>Options for Converting Different Existing PDF Documents</td>
<td>61</td>
</tr>
<tr>
<td>Enhancing Accessibility of PDF documents in Acrobat Pro</td>
<td>67</td>
</tr>
<tr>
<td>Cleaning Up With the TouchUp Reading Order Tool</td>
<td>68</td>
</tr>
<tr>
<td>Adding Content with the TouchUp Reading Order Tool</td>
<td>68</td>
</tr>
<tr>
<td>Removing Content with the TouchUp Reading Order Tool</td>
<td>70</td>
</tr>
<tr>
<td>Reclassifying Content with the TouchUp Reading Order Tool</td>
<td>70</td>
</tr>
<tr>
<td>Evaluating and Controlling Reading Order</td>
<td>71</td>
</tr>
<tr>
<td>Adding Alternative Text to Images in PDF Documents</td>
<td>75</td>
</tr>
<tr>
<td>Defining Table Headers</td>
<td>77</td>
</tr>
<tr>
<td>Forms with Adobe Acrobat Pro</td>
<td>79</td>
</tr>
<tr>
<td>Creating Accessible Interactive Forms</td>
<td>79</td>
</tr>
<tr>
<td>Defining Form Content with Tags</td>
<td>79</td>
</tr>
<tr>
<td>Radio Buttons and Checkboxes</td>
<td>80</td>
</tr>
<tr>
<td>PDF Documents and Web Browsers</td>
<td>80</td>
</tr>
<tr>
<td>Using JAWS with Adobe Reader</td>
<td>83</td>
</tr>
<tr>
<td>Forms with Adobe LiveCycle Designer</td>
<td>85</td>
</tr>
<tr>
<td>Screen-Reader Precedence</td>
<td>85</td>
</tr>
<tr>
<td>Text Fields</td>
<td>86</td>
</tr>
<tr>
<td>Radio Buttons</td>
<td>86</td>
</tr>
<tr>
<td>Radio Button Groups</td>
<td>86</td>
</tr>
<tr>
<td>Checkboxes</td>
<td>87</td>
</tr>
<tr>
<td>Drop-Down Lists</td>
<td>87</td>
</tr>
</tbody>
</table>
For electronic versions of training manuals, a list of upcoming trainings, and other resources, visit our website: www.htctu.net
Creating Accessible PDF Documents with Adobe Acrobat XI (11) Professional for Windows

Publisher
Adobe Systems

Retail Cost
Educational discount for California Community Colleges: http://www.foundationccc.org
Adobe Online Store http://store.adobe.com/store/main.jhtml

System Requirements
NOTE: It is currently not possible to create tagged-PDF documents directly from MS Office applications in Mac OS X. Mac OS X users will need to work within Acrobat Pro exclusively to ensure accessibility of PDF documents.

Windows
• 1.3GHz or faster processor
• Microsoft Windows XP Home, Professional, or Tablet PC Edition with Service Pack 3 (32 bit) or Service Pack 2 (64 bit); Windows Server 2003 (32 bit and 64 bit; Service Pack 2 required for 64 bit); Windows Server 2008 or 2008 R2 (32 bit and 64 bit); Windows Vista® Home Basic, Home Premium, Business, Ultimate, or Enterprise with Service Pack 2 (32 bit and 64 bit); Windows 7 Starter, Home Premium, Professional, Ultimate, or Enterprise (32 bit and 64 bit)

• 512MB of RAM (1GB recommended)
• 1.9GB of available hard-disk space
• 1024x576 screen resolution
• DVD-ROM drive
• Microsoft Internet Explorer 7 or 8; Firefox 3.5 or 3.6
• Video hardware acceleration (optional)

Note: For 64-bit versions of Windows Server 2003 R2 and Windows XP (with Service Pack 2), Microsoft Update KB930627 is required.

Mac OS

• Intel processor
• Mac OS X v10.5.8 or v10.6.4
• 512MB of RAM (1GB recommended)
• 1.2GB of available hard-disk space
• 1024x768 screen resolution
• DVD-ROM drive
• Safari 4 for Mac OS X v10.5.8; Safari 4 or 5.0.x for Mac OS X v10.6.4

Description
Adobe Systems PDF format is widely used online for dissemination of documents. A PDF (portable document format) file is a graphical file that is an exact image of a document originally created by another application (e.g., MS Word file) and then converted by Adobe Acrobat into PDF format. A PDF document can be viewed using Adobe Reader, which is a free viewer program that provides access to the PDF document. The Adobe Reader viewer allows users to view and enter information into a PDF document (where applicable) as well as enlarge the viewing area of the document.
Accessible PDF documents can be created using the Adobe Acrobat software application in conjunction with Microsoft Word, Excel, PowerPoint 2000 (and newer) applications. The use of Adobe Acrobat and a supported word-processing application creates a “tagged” PDF document, where visual document presentation is separated from semantic document content. Assistive computer technology applications have the capacity to then read the “tagged” PDF document to communicate information to the user.

Basic Use Instructions for downloading and installing the latest versions of Acrobat Reader as well as additional Acrobat plug-ins to increase the functionality and accessibility can be found at: http://access.adobe.com.

While this manual focuses primarily on the use of Adobe Acrobat XI (11) Professional to make content accessible, it is possible to use versions 6.0 through 9 Standard or Professional as well (Note: Acrobat Standard does not support form development).

**Overview of Creating Accessible PDF Documents with Acrobat XI**

Typically, you will either be creating a PDF document from another digital document format, such as MS Word or PowerPoint, or you will be working with a PDF document that has no available source document (all you have is the PDF file). In either case, the best option for accessibility is to start work with the source file if possible- but even if you can’t get the original source file, Acrobat Pro will enable you to remedy most accessibility problems.

Most PDF documents begin as some other type of document, such as Microsoft Word or PowerPoint, or Adobe InDesign, etc. Whatever the source document for a PDF is, it is likely to be more efficient to perform the accessibility work in the native authoring environment.

By making your information as accessible as possible before you convert the document to a PDF, you can help ensure that the resulting PDF can be accessible as well as minimize any work required to make the PDF accessible within the Acrobat application.

In this manual the process for creating an accessible Word document will be used as an example of how to deal with the basic aspects of accessibility for most typical documents. Once the work is finished in Word, the process for exporting to PDF and checking for accessibility within Acrobat Pro will be covered, as well as the tools and procedures to remedy any access issues in the PDF using the tools within Acrobat Pro.
Creating Accessible PDF Documents from MS Office Documents

Starting in MS Word for MAC OS X.
If you are using a Mac OS based version of Office, you will need to work within Acrobat Pro to ensure accessibility of your PDF documents.

Starting in MS Word for Windows OS
If you are using a version of MS Office that is 2003/XP or later and running on a Windows operating system, then you have the ability to easily create accessible PDF documents within the MS Office applications. MS Office applications can deliver a properly designed document to the Acrobat PDF conversion process as long as the author has provided the right information.

When the digital information in your document is properly structured and identified, a “tagged” PDF can be created in which all of the information about the document can be communicated to assistive technology, allowing the content of the document to be provided in the appropriate format for the reader, or end-user.

There are three basic concerns in this process:

- Structured text
- Textual descriptions for non-textual content
- Header identification for data tables

With these three issues addressed the great majority of your simple PDF documents can be rendered in an accessible manner.

Structured Text in MS Word
In order to have truly structured text, the text of your document needs to be identified by a style within the MS Word program, and not simply formatted to make the text look a certain way. This allows for semantically defined and structured text- or in other words, by using the “Styles” pane of MS Word, you can identify the text of your document in a way that will provide access for users of assistive technology.

Above: Styles Bar on the “Home” ribbon from MS Word.
Perhaps the most critical styles are paragraph and section headings. These elements are the critical basic building blocks of a digital document, and should be the first thing to focus on when considering accessibility. In MS Word, you control and manage the different styles in your document via the styles pane. By using logical heading structures in your documents you can create more usable and easier to digest information for all readers, as well as providing the structure needed for assistive technologies to deal with the content effectively.

By using the styles “Heading 1”, “Heading 2”, and “Heading 3” you are actually indicating to the MS Word program that this piece of text is semantically different from all the other text. In MS Word, all text is styled and defined as a paragraph by default. The name for the default paragraph style in MS Word is “Normal”.

Above: Expanded Heading Pallete from MS Word.

Headings are styles applied to textual information that indicates what is coming in the following paragraph text. Heading text can be used to quickly gain an understanding of the main points a document is talking about, and headings can be organized with a ranking hierarchy, to help define main topics and sub-topics. Thoughtful use of heading styles can be good for all users, but it is especially valuable for individuals with print disabilities who are using assistive technology to access the information.

Heading 1 should always be used for the title of your document, and depending on the style guide you are following, Heading 1 can be used for chapter headings as well. While many assistive technologies can handle 6 levels of headings, it is often not necessary to go beyond three levels of headings in most simple documents.
Textual Descriptions for Non-Textual Content in MS Word

The general breakdown of accessibility for digital information is that text is the most accessible form of digital content, and all other formats need to be converted to some form of text in order to be accessible.

This means that:

- images get textual descriptions
- audio files get transcriptions
- video files get captions
- complex files get special attention...

In order to be accessible, digital content that is not textual needs to be converted to electronic text or described via electronic text. Electronic text refers to any of the common digital text formats such as ASCII/.txt, MS Word/.doc, HTML, etc. Sometimes digital text information is visible for sighted users, and other times digital text information may be delivered exclusively through non-visual digital means to a variety of technologies such as screen readers, Braille displays, document conversion systems, etc.

The most common non-textual content you will find in typical MS Word documents are images. MS Word allows you to insert a description of the image within the image itself, and when a user of assistive technology encounters this image, the description will be made available as well.

Above: Format Picture Dialog in MS Word.
In order to insert a description into an image within MS Word, right click the image and select the option to “Format Text”, and then select the tab labeled “Alt Text” and insert your description in the text field provided. Now your image is accessible to people who can’t see it but are using assistive technologies to read the document.

**Table Headers in MS Word**

Tables represent a level of complex data that can be easily taken for granted. Sighted people know that any intersection of rows and columns will have some meaning based on the labels for those rows and columns. These labels are called headers, and when they are used properly, the relationship of tabular data can be more easily maintained by users of assistive technologies.

To identify table headers in MS Word, select the contents of the table cells that contain your header labels. Right click the selection and choose “Table Properties”, and then select the tab for “Row”.

![Above: Table Properties in MS Word, Row Tab selected.](image-url)
Once you have selected the “Row” tab, you can then designate the column to “Repeat as header row at the top of each page”. This will ensure that assistive technologies will be able to identify the headers, even if the table doesn’t extend beyond a single page.

**Converting to PDF from MS Word**

Once you have performed the requisite work in MS Word, you can select the settings for converting to PDF and then save your document as a PDF.

Before a document can be translated to the PDF document format from MS Word, it is necessary to check the conversion settings of the Adobe Acrobat PDFMaker within Microsoft Office. The default settings should produce a tagged PDF document from MS Word, but it is always good to ensure the settings are correct.

Within the conversion settings dialog, there are four tabs: “Settings”, “Security”, “Word”, and “Bookmarks”. The options on each of these tabs can affect the accessibility and usability of your PDF document.

![PDF Conversion settings in MS Word with Acrobat Pro XI.](image)

Above: PDF Conversion settings in MS Word with Acrobat Pro XI.
Above: PDF Conversion settings in MS Word (pre-Acrobat XI).

**To check conversion settings:**

1. Open a document in the Microsoft Office application.
2. Choose Adobe PDF from the menu bar, or select the “Acrobat” ribbon (depending on your version of MS Office) and select “Change Conversion Settings” or “Preferences” (depending on your version of MS Office).

**Settings Tab**

1. Make sure that “Enable accessibility and reflow with Tagged PDF” is checked.
2. You can enable “Bookmarks” and “Links” to allow for even greater usability potential in your PDF document.

**Security Tab**

If you are going to restrict the permissions of your PDF document, be sure to enable text access for screen reader viewing by the visually impaired.
Above: PDF Conversion Settings (Security Tab).

**Word Tab**

1. Check the box to “Enable advanced tagging”
2. Check the boxes to convert footnotes, endnotes, and cross reference linking.
Above: PDF Conversion Settings for MS Word (Word Tab).

Bookmarks Tab
The Bookmarks tab allows you to include custom styles as bookmarked elements within your PDF document. You can also organize the bookmarks according to the same hierarchy used for your heading styles.

Creating the PDF Document from MS Office (Summary)
1. Create/open the document in the Microsoft Office application.
2. Use Styles and Formatting tools in MS Office to control the presentation of the document. For example, to identify headings, use the Style menu in the Formatting toolbar to designate various headings or text content in the document. Styles can be manipulated under Styles and Formatting from Format in the menu bar.
3. Describe non-textual content such as images and charts.
4. Define any table headers that may be present.
5. Ensure that your PDF conversion settings include support for advanced tagging and reflow.
6. Name and save the file to begin the conversion process.
7. Open Adobe Acrobat and view the document to verify the document was processed correctly.
Options for Converting Different Existing PDF Documents

PDF documents created using Acrobat Distiller or other basic PDF printing programs generally result in a PDF document that does not contain a document structure (i.e., no tags, or worse yet, image-based PDF). Depending on the visual layout and design of the document, this may lead to increased difficulty for assistive computer technology to gain access to the document content in a logical reading fashion.

The following recommendations are designed to provide guidance when having to choose what type of method is most appropriate to create an accessible PDF document. Generally speaking, it is better to revert to the original file format (e.g., MS Word) when attempting to recreate a PDF as the document can be created with a “tagged” document structure.

Recommendations when using MS Office applications

If the original document is available, open that file in a Microsoft Office application (if possible). Format the presentation of the document using the style elements found under Format on the menu bar. Remember to add appropriate image descriptions to graphics and figures. Once this process is complete, follow the directions under the Creating the PDF Document section.

When You Don’t Have the Source Document

If the original document is not available, open the PDF document in Adobe Acrobat. Follow the directions in the next section, titled “Adding Tags to a PDF Document”.

OCR and Image-Only PDF Documents

If the PDF document exists in an “Image Only” file format, it will be necessary to apply some type of Optical Character Recognition (OCR) to the PDF document image to yield a document containing text content (not a graphic representation of the image). This is similar to starting with a TIFF document from a scanner, and then using an OCR program such as OmniPage, or ABBY FineReader.

You can use the Text Recognition tool in Acrobat to recognize the actual letters and symbols on the page. This is an automated process and may not recognize all text correctly, so be sure to edit your document carefully.

The Text Recognition tool in Acrobat XI may be found under the “Recognize Text” tool bar.
Above: OCR Tools under “Recognize Text”.

Creating Accessible PDF’s with Acrobat XI
Adobe Acrobat Pro XI allows for authors to create and convert accessible PDF documents. The following information explains the basic techniques for creating accessible PDF documents in general. Due to the many different ways an individual can create a PDF document, there may be PDF documents that defy the following advice.

**Tags and Accessibility in PDF Documents**

Adobe Acrobat XI (11) allows users to create a tagged PDF document from untagged PDF files. Tagged PDF documents can provide enhanced user accessibility depending on the document design as well as the capacity to save a PDF document into alternate formats (e.g., HTML, Accessible Text, RTF, etc.). If creating electronic forms, it is necessary to use Adobe Acrobat Professional or Adobe LiveCyle Designer (Windows OS only) to create accessible PDF-based forms.

Adding tags manually to a PDF document does have some limitations. While Acrobat can automatically add tags to a PDF document, there is no guarantee that the document content will be tagged in the correct reading order. Documents that contain regions of high complexity, such as rich visual layouts, may result in a tagged structure that does not follow the logical reading order of the original document. Any graphics or charts in the PDF document may not be processed correctly and may be rendered as “Figures” or “Inline Shapes”. It is necessary to identify these items and add the appropriate alternative text descriptions.

Adobe Acrobat XI (11) includes the “TouchUp Reading Order” tool that allows an author to specify a logical reading order of the PDF document as well as simplify the process of adding image descriptions. The TouchUp Reading Order tool also includes a Table Inspector to improve the accessibility of data tables within PDF documents.

TouchUp Reading Order Tool is available from the Accessibility Tools menu:
Adding Tags

In Acrobat XI, the actions previously associated with menu bars are now available from different “Tool” palettes. In order to add tags, you will need to go to the “View” menu and select the “Accessibility” option from under the “Tools” section.

Here’s how to add tags to your PDF document within Acrobat XI:

1. Open the PDF document that does not contain the tagged structure.
2. Select “Add Tags to Document” from the Accessibility Tools. This will start the tagging process of the PDF document.
3. After the program finishes processing the document, use “Save As” and save the file with a new name.
4. Open the new PDF document to check the logical order of the tagged file.

Adding Alternative Text for Images after Tagging

Some situations will require you to add alternative text to images or figures after adding tags to a PDF document. See the information under the TouchUp Reading Order tool for instructions to add text descriptions after completing the tagging process in Adobe Acrobat.
Enhancing Accessibility of PDF Documents in Acrobat Pro

Acrobat Pro provides several features that can be used to enhance the accessibility of your PDF documents, including automated assessments, and helpful instructions for remedying common accessibility issues.

Automated Accessibility Testing

Acrobat Pro XI includes a “Full Check” for accessibility. Different from previous versions, the Full Check no longer includes Section 508 criteria, but rather, uses a new set of standards Adobe has adopted to help deliver a more accessible experience.

Previous versions of Acrobat Pro have included a Quick Check feature as well as the Full Check. If you are using a version of Acrobat Pro earlier than XI, the “Quick” check simply determines if there are tags present in the PDF document. In order to perform a detailed assessment of the accessibility of your PDF document, you will need to perform a “Full Check”.

Above: Full Check Dialog from Acrobat XI.
In previous versions, the Full Check automated assessment allows you to specify a standard to test the content of your PDF document against. Included are the Section 508 standards, the WCAG standards, and a generalized set of criteria defined by Adobe, which seems to represent a balancing of the Section 508 and WCAG standards. In Acrobat XI, the options in the Full Check no longer specify Section 508 or WCAG, rather the concepts and criteria of these standards have been embraced and absorbed by Adobe.

**Performing a Full Check**

1. Select “Full Check” from the Accessibility Tools
2. Specify a standard to test against
3. Determine whether the test will be captured as an accessibility report
4. Initiate the test.

The test results will be displayed after the test is complete. Any accessibility issues will be listed, including an explanation of how to remedy the issue.
The accessibility issues are linked to the actual content, so when you click on an item from the list, you will be presented with the corresponding content in your PDF document. You can also click on the “Content” view and see a detailed listing of the content that Acrobat assessed as part of your check.

Above: The Accessibility Checker Results.

Above: Right-Click Menu for Content Viewer
The TouchUp Reading Order tool in Adobe Acrobat XI (11) allows you to make corrections to the document structure. After adding tags to a PDF document, the TouchUp Reading Order tool will identify blocks of text, headings, figures, tables, and formulas that are contained within the document structure. If the PDF document contains images (or figures) containing pertinent information, then use the TouchUp Reading Order tool to add the appropriate text descriptions.

While it is possible to manually add and restructure the tags in a PDF document, it is recommended to use the “Add Tags to Document” function followed by the TouchUp Reading Order tool to organize the logical flow of document information. Open the TouchUp Reading Order tool by:

1. Select the “Tools” pane and make sure the “Accessibility” Panel is displayed. (If not visible, go to “Views” and select “Accessibility” from the “Tools” panel.)
2. Choose “TouchUp Reading Order”.

This will open the tool panel in which to make the necessary corrections to the tagged information in the PDF document.

Above: Touch Up Reading Order Tool
Information within the PDF document will be identified as separate regions with a number in the upper left part of the region. This number identifies the logical reading order of the text flow of the document.

Above: Touch Up Reading Order Tool in Pre-XI Versions.

**Adding Content with the TouchUp Reading Order Tool**

When you initially open the TouchUp tool, the PDF document will display the various content regions and the reading order in which the regions will be recognized. However, it may be possible that during the tagging process, some content is missed by the “Add Tags to Document” process. This requires the document author to go back and add information to the PDF tag structure.

To add content via the TouchUp Reading Order Tool:

1. Open the TouchUp Reading Order tool
2. Identify the region of text content that is not part of the page structure (e.g., content will not be within a gray box). Using the cross-hair icon, draw a box around the text information. Make sure that all the text information you wish to include is encompassed by blue squares
3. Select the type of content using the reading order panel.
After you have identified the content type, you will be able to see a gray region encompassing the area you selected. The TouchUp Reading Order tool can be used to add headings, text, figures, tables, and form fields. It is the decision of the author/designer as to how specific they wish to identify the information in the document.

Removing Content with the TouchUp Reading Order Tool

In some cases, it will be necessary to remove content from the document structure. Content that is appropriate for removal may be visual images that are not relevant to the content (e.g., “eye-candy”), information that is misrecognized by the Add Tags to Document tool and does not contain value, or when temporarily separating regions for restructuring.

To remove content:

1. Open the TouchUp Reading Order tool
2. Using the cross-hair icon, draw a box around the region of content you wish to remove from the document structure
3. In the TouchUp Reading Order dialog window, select the “Background” button. This will remove any gray regions from around the content as well as remove the content from the document structure.

Special Note
By removing information from the document structure you are ensuring this information will not be communicated to an individual utilizing assistive computer technologies and potentially limiting document access.

**Reclassifying Content with the TouchUp Reading Order Tool**

After running the Add Tags to Document function, you may wish to reclassify the information or correct any mistakes the “Add Tags” process may have created. For instance, it is possible that the “Add Tags” process identifies each region on a page as a “Figure”, which may not be the true nature of the content. A description of the different content options is listed in the Adobe Acrobat Help menu, under “TouchUp Reading Order Options”.

In addition to correcting the designation of the content, you may wish to create Bookmarks from the different headings within the document. By specifying the correct content as headings using the TouchUp Reading Order tool, it is possible to automatically create a list of Bookmarks.

**Reclassifying a Region**

To reclassify a region:

1. Open the TouchUp Reading Order tool
2. If reclassifying the entire region, click on the number in the upper left corner of the highlighted region. In the TouchUp Reading Order palette, identify the new content type (e.g., Text, Figure, Formula, etc.).

The selected region will change to the newly identified content type.

**Reclassifying a Part of a Region**

To reclassify part of a region:

1. Open the TouchUp Reading Order tool
2. Using the cross-hair icon, draw a box around the content you wish to change the document structure. Make sure that there is a blue outline around all the content you are changing
3. In the TouchUp Reading Order palette, identify the new content type (e.g., Text, Figure, Formula, etc.).

The regions should now split into two (or more) distinct regions. Regions can be noted by the gray box surrounding the content as well as a number in the upper left corner.
Evaluating and Controlling Reading Order

Adding tags to a PDF document can improve the accessibility of a document by including structure that can be manipulated to ensure a logical reading order to the document. However, the resulting structure that is created when applying the “Add Tags to Document” function may vary. As a result, it may become necessary to reorder information using the TouchUp Reading Order tool so the content is presented in a logical manner.

Above: Reading Order Panel
There are several methods for evaluating the logical reading order or the PDF document content. You can save a PDF document as text and read the information, review the identified regions with the TouchUp tool, or inspect content using the “Order” navigation tab.

**Save as Text**

To save as text:

1. Choose “File” from the menu bar and select “Save As”
2. Under the “Save File As Type” menu, choose “Text (Accessible)”
3. Open the text file to review for errors in the logical flow of the document.

This method will extract the text content of the PDF document (and associated text descriptions, form field content, etc.) and provides a method to assess the reading order of content in the PDF document. While this is not a precise test, it can be used to quickly examine if there are major errors in how document content may be rendered by assistive computer technology.

**Reading Order with the TouchUp Reading Order Tool**

To use the TouchUp Reading Order Tool:

1. Open the TouchUp Reading Order tool
2. Identify the two regions which are out of the correct reading order. Move the cross-hairs to the number in the upper left corner of the region you wish to move (the pointer should change to a “hand” icon)
3. Click and drag the number to the new location within the other specified region. The icon will change to a “caret” icon to assist you with precise placement of the content. You may need to zoom into the document in order to ensure correct placement.

The regions will automatically re-number to show the order in which information will be organized in the PDF document structure. However, the regions will NOT move visually in the PDF document.

**Reading Order Using the Order Tab**

1. Select “View” on the menu bar and choose “Navigation Panels”, and then select “Order”.
2. The Order tab will demonstrate each page and the associated content on each page. Child elements on each page represent the specific regions of content and are numbered sequentially.
3. Move the child element to its appropriate position on the specific page. This will reorder the sequence of the regions in the PDF document structure and change the logical reading order.

Content that is changed in the Order tab will also be changed in the Tags panel. However, the information in the Order panel is specific to the content of the page rather than the structural elements of the page. When you need to change specific structural elements (e.g., language setting, etc.), it is necessary to use the Tags panel.

**Reading Order and the Tags Panel**

The Tags Panel provides the user with the ability to view the underlying structure of the PDF document. With the Tags Panel, the PDF document creator can manipulate the structure of the document as well as the informational content contained within the various tag levels. For example, a PDF document author can insert text descriptions, reclassify headings, etc. for various elements after creating the PDF document.

**Special Note:** It is not recommended to manipulate tags in order to specify PDF reading order. Instead, use the TouchUp Reading Order tool (previous section) in order to improve the logical flow of information in a document.

1. Open a tagged PDF document in Adobe Acrobat (A non-tagged PDF document will not show information in the Tags Palette).
2. Select “View” from the menu bar and then select “Navigation Panels”.
3. Choose “Tags” from the menu. Drag the “Tags” panel to the left side of the screen next to the tab labeled “Bookmark”. This will provide easy access to the Tags Panel while working on a document.

Once the tagged structure of the PDF document is revealed, it is relatively easy to make changes to the content structure. Simply select the appropriate level heading where you wish to make the change and click the right-mouse button. The menu will provide different options based on the heading content you have selected. For instance, it is not possible to add a New Child Element to the actual content in the Tags Palette, but you may add a New Child Element to the heading associated with the appropriate content. In this way, it is possible to add alternative text for graphics or provide the necessary accessibility options when creating forms for PDF documents.

It may be difficult to locate the specific tag for a given image (or text block) when working in a document. It may be easier to locate content and the respective tag by enabling the “Highlight Content” feature in the Tags Panel. The Highlight Content feature is available from the “Option” menu in the Tags Panel or by performing a right-mouse button click on a tag.
Often tagged levels will appear in the Tags Panel, but not refer to page content or improperly refer to PDF document content. It is possible to remove (or add) information to make the PDF document content more accessible to assistive computer technology.

**Adding Alternative Text to Images in PDF Documents**

If you are using images in a PDF document created from MS Word/Excel/PowerPoint, it is possible to add a text description for the image within the Microsoft Office application (on a Windows operating system). This method should be used for image content that is relatively simple and does not require extensive description of the image. If a longer description of the image is necessary to fully explain its content, consider inserting a more detailed description of the image within the document text preceding and/or following the image. For additional information regarding adding text descriptions to images, visit: [http://www.webaim.org/techniques/images/](http://www.webaim.org/techniques/images/)
To insert a text description

1. Open the Touch Up Reading Order Tool.
2. Select the image and right-click the number next in the upper left-hand corner of the image.
3. Choose “Edit Alternate Text”
4. Enter an appropriate alternate text description.
5. Select “OK”.

![Alt Text Entry Dialog]

Above: Alt Text Entry Dialog.

Fixing Tables

Tables provide the ability to visually present related pieces of information in a quick and easy format. Similar to data tables on the Web, assistive computer technology may not be able to recognize table headers and render the content information in a recognizable manner to the individual. Rather, the user is relegated to navigating through the table, hearing information while attempting to discern relationships between the various pieces of information. To create a table for a PDF document, begin by using the Table formatting option in the appropriate word processing program. Once you have converted your document to a PDF, you can use the Table Inspector tool to include additional structure to improve accessibility for assistive computer technologies.

Special Note: Do not use “spaces” or “tabs” to visually format a table as this will create the incorrect content in the tagged PDF document!

Table Inspector

The Table Inspector is used for viewing and including the appropriate markup for PDF-based data tables. The Table Inspector can be accessed from the TouchUp Reading Order Tool and used to define the table headers and/or table data in a data table. Defining such elements can assist in the recognition of the table information when accessed using assistive computer technology.
Defining Table Headers

1. Open the PDF document containing the data table to be repaired and enable the TouchUp Reading Order Tool (ensure the PDF document has been tagged as a “Table” or the Table Inspector will not be available).

2. In the PDF, select the numerical value in the table label region. Once the table has been selected, press the Table Inspector button in the TouchUp Reading Order Tool.

3. By default, table header cells will have a red background. If a table header is not properly shaded, click on the cell and then right-click to open the Table Cell Properties.

4. Define the table header cell by selecting the appropriate radio button and choose the scope from the drop-down list (i.e., Row, Column, Both, None). The scope value sets that specific cell information as the header content for the entire table row or column.

5. Press “OK” to return to the Table Inspector interface and finish adding table header information to the appropriate row or column cells.

Above: Table Cell Properties Dialog.
While assistive computer technology may recognize the <Table> tag in the tagged PDF, it may not recognize the correct column and row heading information even after this content is properly identified. It is recommended to add this information to a PDF data table even if subsequent testing with assistive technology does not reveal improvements to the table interpretation. This is a current issue with assistive computer technology and future versions should be able to support such tagging.

Description of PDF Table Tags

For those who use the Table Inspector:

4. The <Table> element should be the first markup “tag” before any content in the table is described.

5. Following the <Table> element, a <THead> and <TBody> may be the next child tags. The <THead> and <TBody> tags separate the table into the header or body elements.

6. Under the <THead> and <TBody> tags, the <TR> element should be the next child element as this contains all the information for the first, second, third, etc., row. <TR> is the table markup for Table Row.

7. After <TR>, the next child element should be either <TD> or <TH>. <TD> is the markup for Table Data and represents the information within a specific cell. <TH> is the markup for Table Header and represents the header data for a specific column or row.
Forms with Adobe Acrobat Pro

Forms in PDF documents allow users to enter content into a form field and print the PDF page or save the document to a file. Similar to Web page forms, PDF document forms can be created as a one-line Text box, Combo Box, List Box, or Radio Button. Additionally, information can be added to PDF forms to improve the ability of assistive computer technology to access the form field and prompt the user to input the correct information. Forms that users can read and complete electronically with the computer are called “interactive forms”.

Another application that you may wish to consider is Adobe LiveCycle Designer. This tool allows for the easy creation of electronic forms and generates a tagged PDF file upon completion. This tool is recommended if you are using forms that may vary in layout or content over time and will significantly reduce the necessary time to re-create accessible PDF forms. More information about using Adobe’s LiveCycle Designer is available in the next section.

Above: Forms Tools.

Special Note

It is very important to not use keyboard characters to visually format the form fields (e.g., creating lines for signatures using the “underscore” character, etc.). Rather, use Adobe Acrobat Professional or the Adobe LiveCycle Designer tool to create these visual references when constructing PDF forms.

Creating Accessible Interactive Forms

You must first create a tagged PDF document before adding the necessary form tags. Follow the instructions “Creating a New PDF Document” if you do not have a tagged PDF document.

Once you have a tagged PDF document, select the “Forms” toolbar from the View menu.
Defining Form Content with Tags

The following steps describe the process for creating accessible form elements within Acrobat Pro.

1. Turn on the Tags tab.

2. Under the “Options” menu in the Tags Palette, enable “Highlight Content” and “Tag Annotations”.

3. Choose the content in the tag structure that immediately precedes where the form field will be located. For instance, if you are going to enter a form field after the “First Name:” text, then it is necessary to select the tag with the correct text.

4. Select the appropriate form tool from the formatting bar.

5. Create a form field of the desired size by clicking the mouse button and dragging the crosshairs to the correct dimensions. When you create this form field, the necessary form tags will automatically be placed into the correct location in the tags palette.

6. Enter a unique form field name in the “Name” text field in the Field Properties dialog box.

7. Enter supporting information in the “Tool Tip” text field. The information provided in the “Tool Tip” text field can be accessed by assistive computer technology to prompt the user to enter the correct information.

8. Under the “Appearance” tab, choose the options you desire for your form field. Under the “Line Style” option, you may select “Underlined” to visually represent a line for information.

Above: Form Properties with Tooltip Field Circled.
The correct tag will automatically be added to the tags palette at the location you specified before drawing in the necessary form field.

The benefit of this tag is that it will provide information to individuals using assistive computer technology to navigate and complete the appropriate form field elements.

**Radio Buttons and Checkboxes**

If your form requires the use of radio buttons and checkboxes, make sure to use these form input elements correctly. Radio buttons should be used when you wish to have only one answer reported (i.e., True or False, Male or Female, etc.). Checkboxes should be used when you wish to have none or more than one answer reported (i.e., A and B, Lunch and Dinner, etc.).

In either case, it is possible to identify the export value of the radio button and checkbox for a specific form input element. In the field properties window, select the “Options” tab and enter a value for “Export Value”. This information will be spoken when using a screen-reader.

For additional information on creating PDF document forms, reference the Adobe Acrobat XI (11) Help Topics. Additional information can also be found in Advanced Techniques for Creating Accessible PDF Files manual from Adobe Systems. For forms that require periodic updating and editing, it is recommended to review Adobe Designer as this may streamline accessible PDF form creation.
Adobe Acrobat (and Adobe Reader) both offer the capability to view PDF documents from within the web browser interface. However, this integration can make it very difficult for individuals with visual impairments (or using screen-readers) to gain access to the PDF document content. It is possible to disable PDF integration with web browsers by following the steps below.

**For Adobe Acrobat**

1. Open Adobe Acrobat under the Administrator profile.
2. Choose “Edit” from the menu bar and select “Preferences”.
3. Select “Internet”, and then uncheck “Display PDF in Browser” and “Check browser settings when starting Acrobat”.
4. Select “OK”.

**For Adobe Reader**

1. Open Adobe Reader by double-clicking on the desktop icon or starting it from the Start menu.
2. From the Edit menu, select Preferences, then Options on the left side of the dialog box.
3. In the Web Browser options, deselect the “Display PDF in Browser” option and click OK.

**Using JAWS with Adobe Reader**

<table>
<thead>
<tr>
<th>Description</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Forms Mode</td>
<td>ENTER</td>
</tr>
<tr>
<td>Virtual Cursor On</td>
<td>NUM PAD PLUS</td>
</tr>
<tr>
<td>Virtual Find</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Links List</td>
<td>INSERT+F7</td>
</tr>
<tr>
<td>Next Page</td>
<td>CTRL+PAGE DOWN</td>
</tr>
<tr>
<td>Previous Page</td>
<td>CTRL+PAGE UP</td>
</tr>
<tr>
<td>Go to Page</td>
<td>CTRL+SHIFT+N</td>
</tr>
<tr>
<td>Go to First Page</td>
<td>CTRL+SHIFT+PAGE UP</td>
</tr>
<tr>
<td>Go to Last Page</td>
<td>CTRL+SHIFT+PAGE DOWN</td>
</tr>
</tbody>
</table>
Forms with Adobe LiveCycle Designer

Adobe LiveCycle Designer no longer comes with Adobe Acrobat Professional (PC-only), but it can still be used to create accessible, interactive PDF forms.

While LiveCycle Designer 4 can create accessible PDF forms, these forms can no longer be edited within Acrobat Pro once they are saved out of LiveCycle Designer.

As of this writing, LiveCycle Designer still does not allow for a language declaration to be made for the document. It appears that the language declaration is the only issue currently unresolved in the LiveCycle Designer workflow.

LiveCycle Designer allows for a drag-and-drop method to create form fields and generates a tagged PDF file upon completion. This tool is recommended if you are using forms that may vary in layout or content over time and will significantly reduce the necessary time to re-create accessible PDF forms. Additionally, the LiveCycle Designer interface can be used to embed specific instructions into different form fields to improve form functionality with assistive computer technologies.

The following information is a basic guide to creating PDF-based forms with LiveCycle Designer that support assistive computer technologies. For a full description of the features and options to use with Adobe LiveCycle Designer, it is recommended to review the Help menu on Using LiveCycle Designer > Creating Accessible Forms.

**Screen-Reader Precedence**

Adobe LiveCycle Designer allows a form author to set specific content that may be heard by individuals using screen-reading applications. The Screen-Reader Precedence option can be set to the following options:

1. Custom Text
2. Tool Tip
3. Caption
4. Name
5. None

Only one of these options will be communicated to the screen-reader.

Because only one of these options can be communicated to the screen reader, it is not possible to set the precedence to Custom Text and also have the Tool Tip information communicated. Depending on the complexity of the form, you must select one of these options to support the form user.

To provide customized instructions, open the Accessibility Palette and set the Screen-Reader Precedence option as “Custom Text”. Enter information into the Custom Screen Reader Text field to communicate to the screen-reader specific instructions. This may be a useful option when communicating information necessary for successful form completion in highly complex form designs.
A form author may decide to set the Screen Reader Precedence to the Tool Tip option, instead. In this situation, the Screen Reader Precedence is set to Tool Tip and the form author would enter text information into the Tool Tip field.

Other options that can be considered for screen-reader precedence are: the form Caption; the form Name; or None (i.e., nothing is communicated to the screen-reader).

Depending on the screen-reader precedence option selected a screen-reader user will receive different information. It is important to consider what information — and amount — will be necessary to ensure successful form completion by all potential users.

**Text Fields**

A text field is an edit box for a user to enter some type of text information. This may be as simple as an entry field to collect an individual’s name, address, or phone number.

1. Drag the Text Field object from the Library to the appropriate location on the page.

2. Change the caption to the appropriate text content (e.g., First Name: ). The caption is the text content associated with the form field.

3. Switch to the Accessibility Palette (right-click on the form object and choose Palettes > Accessibility). In the “Tool Tip” region, enter the instruction you wish to communicate to the individual using assistive technology and set the Screen Reader Preference option to “Tool Tip”. This will cause the screen-reader to speak the Tool Tip information.

4. If you do not wish to use the Tool Tip field and the form caption contains significant information for successful form completion, set the Screen Reader Preference option to “Caption”.

**Radio Buttons**

Radio buttons are distinguished as “either-or” answers; multiple selections are not permitted for a group of radio buttons.

When one radio button is selected, the others in the group are deselected. If there is a need to allow multiple answers for a particular question, consider a group of checkboxes.

**Radio Button Groups**

If you are working with a series of radio buttons, it is important to group these radio buttons together. Radio buttons are grouped together with the same “Name” value (Object Palette > Binding).

When adding a set of radio buttons to the page, a new radio button will automatically be grouped with other radio buttons of the same Name value.
If a new form object (not a radio button) is added to the page and then additional radio buttons are added, the new radio buttons will form their own separate group (different Name value).

It is important to recognize the correct group of radio buttons selected when applying accessibility information.

1. Drag the Radio Button form object from the Library to the appropriate location on the page. Radio buttons with the same “Name” value will be grouped together (under the Object Palette).

2. Select the group of radio buttons and open the Accessibility Palette. Enter the question in the Custom Screen Reader Text field. Set the Screen Reader Precedence option to “Custom Text”. This will speak the question to the individual as they move between the radio buttons.

3. Change the caption to the appropriate text content for each radio button. The caption is the text content associated with that specific radio button.

4. In the Object Palette, open the Bindings tab and uncheck the box “Specify Item Values”. This will result in the screen-reader speaking the radio button caption as the individual moves through the radio button group.

**Checkboxes**

Checkboxes are used when there may be multiple responses to a specific question as opposed to radio buttons that only allow one response.

Checkboxes are not grouped in the same manner as radio buttons and so a different process is necessary to ensure the appropriate information is communicated to the individual.

1. Drag the Checkbox form object from the Library to the appropriate location on the page.

2. Change the checkbox caption to the appropriate text content. The caption is the text content associated with the form field.

3. Switch to the Accessibility Palette (right-click on the form object and choose Palettes > Accessibility). In the Tool Tip region or Custom Screen Reader Text region, enter the question and answer for the specific checkbox. Set the Screen Reader Precedence to the Custom Text or Tool Tip option.
Drop-Down Lists

A drop-down list may be another option instead of radio buttons when expecting the individual to select only one option. With drop-down lists, it is important to avoid adding scripting to the object that triggers an automatic change when the option is selected (i.e., when using the up/down arrow keys). This is usually accomplished by setting an “onChange” or “onSelect” type attribute. Drop-down lists may also be opened using the Alt + Down Arrow keystroke to reveal all the selection options.

1. Drag the Drop-down List object from the Library to the appropriate location on the page.

2. Change the caption to the appropriate text content. The caption is the text content associated with the form field.

3. Switch to the Accessibility Palette (right-click on the form object and choose Palettes > Accessibility). In the “Tool Tip” region, enter the instruction you wish to communicate to the individual using assistive technology and set the Screen Reader Preference option to “Tool Tip”. This will cause the screen-reader to speak the Tool Tip information.

If you do not wish to use the Tool Tip field and the form field caption contains appropriate information for successful form completion, set the Screen Reader Preference option to “Caption”.

For more information about creating accessible PDF-based forms, please review the Help topic Using LiveCycle Designer > Creating Accessible Forms.